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Modifying the Chemical Record File of a Chemical

A Chemical Record File. contains several types of information which you may enter and modify through 
window panes and dialog boxes. Figure 1 defines the various elements in the Easy C Base window. 

See the topic An Eample for a simple example on how to use Easy C Base.

See the topic Basic Concepts for an introduction to ideas essential to using Easy C Base.

See Index to get help on the different Easy C Base menu commands.



Technical Support

Please consult your manual for the Technical Support telephone number.

Easy C Base is continuously being improved and more Basic Structural Units added. Priority is given to 
BSU's that you, the users, have indicated interest in. Please be sure to let us know of any problems or 
suggestions you may have. 

Call or write to us at the following address:

Novel Advanced System Corp.
P.O. Box 130304
Ann Arbor, MI 48113-0304

E-Mail :    snaser@aol.com



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Easy C Base.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new Chemical Record File.

Open an existing Chemical Record File.    Easy C Base displays the Open dialog box, in which 
you can locate and open the desired file.

Save the active Chemical Record File with its current name.    If you have not named the 
Chemical Record File, Easy C Base displays the Save As dialog box.

Removes selected data from a Chemical Record File's window and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point or red focus square.

Find a given string in the Text Window Pane. 

Give the currently active file's chemical a name.

Search for a Chemical Record File by structure or substructure it contains, and by a text string it 
contains.

toggle Structure Window Pane between full and fit in window views.

Print the active Chemical Record File's structure.

Print the active Chemical Record File's description.

Invoke Easy C Base help facility.

Go into context sensitive help mode.





Preferences menu commands

The Preferences menu offers the following commands:

CRF Database Invokes a dialog box which allows you to select and set the 
Chemical Record File Database default directory. The path you 
select will be saved and used for future sessions.

H- Warning On Switches on the warning message for when you attempt to connect 
a hydrogen to a BSU that is not monovalent. See Hydrogen, a 
special case BSU.

H- Warning Off Switches off the warning message for when you attempt to connect 
a hydrogen to a BSU that is not monovalent. See Hydrogen, a 
special case BSU.



Software Registration:
Easy C Base™ is protected by Copyright Law. 
If you like Easy C Base™ and are using it regularly, then you should register it and pay the registration 
fee of $68.

When you register your copy of Easy C Base™, you get the following extras:

1- Latest version without the opening dialog box and DEMO version restrictions.
2- A printed manual.
3- One free upgrade. 
4- Technical support    telephone number in addition to E-mail.
5- You insure the continuing improvement and expansion of Easy C Base™.
6- Information about products that use the Easy C Base™ interface: GC-Estimate™, Polymer-

CAD™, Extraction-CAD™, and UNIF-ACT™.

You may use CompuServe SWREG Registration ID 3842, OR, you may print this help topic and mail the 
completed form below with your registration fee of $68 to:

Dr. Samer F. Naser
Novel Advanced System Corporation
P.O. Box 130304
Ann Arbor, MI 48113-0304

Please provide the following information:

NAME:_______________________________________________________

ADDRESS:
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________

TELEPHONE:_______________________ FAX:__________________

What are you using Easy C Base™ for? (please circle): 
Personal Educational Research IndustryBusiness Other(specify):

Are you a student? Yes No

What you really like, and really dislike about Easy C Base™:

ANY QUESTIONS, COMMENTS?      Contact me at:
CompuServe ID: 73543,3541
America Online: Snaser
internet : 73543.3541@compuserve.com

snaser@aol.com
*****************



File menu commands

The File menu offers the following commands:

New Creates a new Chemical Record File.

Open Opens an existing Chemical Record File.

Close Closes an opened Chemical Record File.

Save Saves an opened Chemical Record File using the same file name.

Save As Saves an opened Chemical Record File to a specified file name.

Print Structure Prints the structure from the active Chemical Record File.

Print Text Prints the text description from the active Chemical Record File.

Print Preview Displays the Chemical Record File on the screen as it would appear printed. 
Depending on which window pane is active, either the structure or the text 
description is previewed.

Print Setup Selects a printer and printer connection.

1, 2, 3, 4 Opens the Chemical Record File whose name is displayed opposite the number.

Exit Exits the application.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation in the Text Window Pane only.

Cut Deletes a BSU from the Structure Window Pane or text from the Text Window 
Pane and moves it to the clipboard.

Copy Copies a BSU from the Structure Window Pane or text from the Text Window 
Pane to the clipboard.

Copy Structure Copies a the entire structure from the Structure Window Pane to the 
clipboard. It can then be Pasted into other applications as a bit map.

Paste Pastes a BSU or text from the clipboard into the Structure Window Pane or 
the Text Window Pane.

Delete Deletes selected BSU or text without affecting the clipboard.

Find Finds a given text string in the Text Window Pane.

Find Next Repeats the last Find operation in the Text Window Pane.

Replace Replaces a given text string in the Text Window Pane with another text string.

Select All Selects all the text in the Text Window Pane.



Chemical menu commands

The Chemical menu offers the following commands:

Name Invokes a dialog box which allows you to name the chemical.

Search Invokes a dialog box which allows you to search for Chemical 
Record Files which contain a given structure or substructure, and a 
text string.

Fit in 
Window

Toggles the active Chemical Record File's structure view between 
full and fit in window.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar of the active Chemical Record File. 
To affect the main status bar, there should be no active files. 

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple 
Chemical Record File in the main window:

Cascade Arranges windows in an overlapped fashion.

Tile Arranges windows in non-overlapped tiles.

Arrange Icons Arranges icons of closed windows.

Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands: 

Index Offers you an overview of the application and an index to topics 
on which you can get help.

Context Mode Context sensitive help. Displays help topic for a clicked on 
window item.

Using Help Provides general instructions on using help.

About Displays information about this application program.



New command (File menu)

Use this command to create a new Chemical Record File in Easy C Base. 

You can open an existing Chemical Record File with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing Chemical Record File in a new window.    You can open multiple 
Chemical Record Files at once.    Use the Window menu to switch among the multiple open Chemical 
Record Files.    See Window 1, 2, ... command.

You can create new Chemical Record Files with the New command.

<Important Note #1> 

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which Chemical Record File to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. The default extension is .ecb .

List Files of Type
Select the type of file you want to open from either Easy C Base files (i.e. *.ecb) or all files (i.e. *.*)

Drives
Select the drive in which the file that you want to open is stored. 

Directories
Select the directory in which the file that you want to open is stored.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<Important Note #1>



Close command (File menu)

Use this command to close the window containing the active Chemical Record File.    Easy C Base 
suggests that you save changes to your Chemical Record File before you close it.    If you close a 
Chemical Record File without saving, you lose all changes made since the last time you saved it.    Before 
closing an untitled Chemical Record File, Easy C Base displays the Save As dialog box and suggests that 
you name and save the Chemical Record File.

You can also close a Chemical Record File by using the Close icon on the Chemical Record File's 
window, as shown below:



Save command (File menu)

Use this command to save the active Chemical Record File to its current name and directory.    When you 
save a Chemical Record File for the first time, Easy C Base displays the Save As dialog box so you can 
name your Chemical Record File.    If you want to change the name and directory of an existing Chemical 
Record File before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active Chemical Record File.    Easy C Base displays the Save 
As dialog box so you can name your Chemical Record File. 

To save a Chemical Record File with its existing name and directory, use the Save command.

<Important Note #1>



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a Chemical Record File with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    Easy C Base adds the extension 
you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the Chemical Record File.

Directories
Select the directory in which you want to store the Chemical Record File.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<Important Note #1>



 1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four Chemical 
Record Files you closed.    Choose the number that corresponds with the Chemical Record File you want 
to open.



Exit command (File menu)

Use this command to end your Easy C Base session.    You can also use the Close command on the 
application Control menu.    Easy C Base prompts you to save any Chemical Record Files if there have 
been changes made since the last Save command.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo command (Edit menu)

This command applies to the Text Window Pane only and allows you to reverse the last editing action. 

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

This command applies to both the Structure Window Pane and the Text Window Pane depending which is 
the currently active window.

In the Structure Window Pane:
Use this command to remove the currently selected BSU from the Chemical Record File's    Structure 
Window Pane and put it on the clipboard.    This command is unavailable if the red focus square is not on 
a BSU.

In the Text Window Pane :
The currently selected text from the Chemical Record File's Text Window Pane is removed and placed on 
the clipboard. This command is not available if there is no text selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

This command applies to both the Structure Window Pane and the Text Window Pane depending which is 
the currently active window.

In the Structure Window Pane :
Use this command to copy the currently selected BSU from the Chemical Record File's    Structure 
Window Pane and put it on the clipboard.    This command is unavailable if the red focus square is not on 
a BSU. This copy operation copies to an Easy C Base private clipboard, and therefore does not affect the 
Windows clipboard. See the Edit Copy Structure command on how to export the whole structure to other 
applications using the Windows clipboard. 

In the Text Window Pane :
The currently selected text from the Chemical Record File's Text Window Pane is copied and placed on 
the clipboard. This command is not available if there is no text selected.
Copying text to the clipboard replaces the contents previously stored there. It replaces contents of the 
Windows clipboard.

Shortcuts

Toolbar:
Keys: CTRL+C



Copy Structure command (Edit menu)

This command will copy the structure in the Structure Window Pane to the clipboard. For applications that 
support bit maps, you may use the Paste command within these applications to copy the structure into 
the application. You may, for example, use this command to put a copy of the structure into an MS WORD 
document or into Paintbrush.

Shortcuts
Keys: CTRL+K



Paste command (Edit menu)

This command applies to both the Structure Window Pane and the Text Window Pane depending which is 
the currently active window.

In the Structure Window Pane :
Use this command to insert a copy of the BSU stored on the Easy C Base private clipboard at the point 
where the red focus square is. This command is unavailable if the clipboard is empty.

In the Text Window Pane :
Use this command to insert a copy of the clipboard contents at the insertion point in the Text Window 
Pane. This command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Delete command (Edit menu)

This command applies to both the Structure Window Pane and the Text Window Pane depending which is 
the currently active window.

In the Structure Window Pane :
Use this command to delete the BSU at the point where the red focus square is. This command is 
unavailable if the red focus square is not on a BSU.

In the Text Window Pane :
Use this command to delete the current selection in the Text Window Pane. 

Shortcuts
Keys: Del , Delete



Find command (Edit menu) 

This command applies only to the Text Window Pane. It searches within the Chemical Record File for a 
text string that you supply through a dialog box. If you select a text string with the mouse, that string will 
automatically be supplied to the Find Dialog Box.

Shortcuts

Toolbar:



Find dialog box

Use this dialog box to find text in the Text Window Pane:

Find What: 
the string to look for in the textual part of the Chemical Record File..

Match Case: 
when checked, searches matching upper and lower case characters as entered.

Direction: 
search Up or Down the file from where the pointer is currently is.

Find Next: 
go to the next occurrence of the search string.

Cancel: 
close the dialog box.

Help: 
display this help message.



Find Next command (Edit menu) 

Finds the next occurrence of the string given in the previous find command.

Shortcuts
Keys: F3



Replace command (Edit menu)

This command applies only to the Text Window Pane. It searches within the Chemical Record Files for a 
text string that you supply through a dialog box, and replaces it with another. If you select a text string 
with the mouse, that string will automatically be supplied to the Replace Dialog Box.



Replace dialog box

Use this dialog box to find and replace text in the Text Window Pane:

Find What: 
the string to search for in the textual part of the Chemical Record File.. The search proceeds 
downward from the current pointer position.

Replace with: 
the string to substitute in place of the search string

Match Case: 
when checked, searches matching upper and lower case characters as entered.

Find Next: 
go to the next occurrence of the search string without replacing the current occurrence.

Replace: 
replace the string that was found, and look for the next occurrence of the search string.

Replace All: 
replace all occurrences of the search string with the replacement string.

Cancel: 
close the dialog box.

Help: 
display this help message.



Select All command (Edit menu)

This command applies only to the Text Window Pane. It selects all the text in the current Chemical 
Record File and is useful for copy and delete operations.



Name command (Chemical menu)

Invokes a dialog box which allows you to specify a name that appears in the Status Bar of the window    
(see Figure 1)as well as in the list box which displays the results of a search for a chemical (see Search 
command).

See the Chemical Name dialog box for more details.

Shortcuts

Toolbar:



Search command (Chemical menu)

Invokes a dialog box which allows you to search for a given chemical in the database using its exact 
structure or a substructure it contains. You may use any of the structures in any of the Structure Window 
Panes displayed as the criterion for the search. For more details on how the structure searches are 
performed, see Structure Search Rules.

You may combine the structural search criterion with a text string search requirement (a logical AND). The 
database is searched and any Chemical Record File whose chemical name or text description contains 
the specified string is retrieved.

The search results are displayed in a list box which shows the chemical's name as well as the name of 
the Chemical Record File that contains it. You may elect to open up to five of these Chemical Record 
Files at any one time. 

If a search is performed with no criteria specified, all the Chemical Record Files in the currently selected 
database directory are displayed.

The search command invokes the search dialog box.

Shortcuts

Toolbar:



Chemical Search dialog box:

This dialog is used to specify the search criteria to be used to search the current database.

The following search options are available:
1- search the database for the exact structure in the chosen window.
2- search for a substructure, i.e., finds the structure that contains the structure in the chosen 

window. The search substructure is a subset of the one to look for.
3- look for a string that matches the given string, ignoring case. The search looks in both the 

chemical's name field and the textual description.
4- find records that satisfy both 1 and 3. (A logical AND search.)
5- find records that satisfy both 2 and 3. (A logical AND search.)

To get information on a particular element in the dialog box, just click on it:



Fit in Window command (Chemical menu)

Use this command to switch between a global view of the Structure Window Pane, and the normal local 
view with the scrolling capability. Note that the global fit in window view may not be very clear on smaller 
monitors. To improve clarity, make the Structure Window Pane as large as possible by reducing the size 
of the other two window panes.

Shortcuts

Toolbar:



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in Easy C Base, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Status Bar command (View menu)

Use this command to display and hide the Status Bar of the active Chemical Record File's window. If no 
windows are open, then this command applies to the main application status bar. A check mark appears 
next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

There are two types of Status Bars in Easy C Base: 
A Status Bar specific to each Chemical Record File.
A Status Bar for the whole application.

Status Bar specific to each Chemical Record File (see Figure 1):
This status bar appears at the bottom of each Chemical Record File's window and displays the chemical's 
name, its calculated molecular formula, and its calculated molecular weight. 

Status Bar for the whole application:

The Status Bar is displayed at the bottom of the Easy C Base window.    To display or hide the Status Bar, 
use the Status Bar command in the View menu when there are no windows displayed within the main 
application window.

The left area of the Status Bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the Status Bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open Chemical Record File window at the bottom of the main window, then some or all of the 
icons may not be visible because they will be underneath this Chemical Record File window.



1, 2, ... command (Window menu)

Easy C Base displays a list of currently open Chemical Record File windows at the bottom of the Window 
menu.    A check mark appears in front of the Chemical Record File name of the active window.    Choose 
a Chemical Record File from this list to make its window active. 



CRF Database (Preferences menu)

This command invokes a dialog box which allows you to choose and set the Chemical Record File 
Database Directory for this and future sessions. In the dialog box, click on the Change button to get a file 
selection dialog box which is identical to the File Open dialog box. When you find the desired directory, 
double click on any of the files in it, or select any file and click OK. Click the Accept button in the original 
dialog box to accept the new CRF Database Directory path. 

The CRF Database for the current session may be changed by any of the File Open or File Save As 
commands. See: Important Note #1 for details.



CRF Database Directory dialog box
This dialog box allows you to choose and set the Chemical Record File Database Directory for this and 
future sessions. In the dialog box, click on the Change button to get a file selection dialog box which is 
identical to the File Open dialog box. When you find the desired directory, double click on any of the files 
in it, or select any file and click OK. Click the Accept button in this dialog box to accept the new CRF 
Database Directory path. 

The CRF Database for the current session may be temporarily changed by any of the File Open or File 
Save As commands. See: Important Note #1 for details.



H- Warning On (Preferences menu)

Prevents you from connecting a hydrogen to a BSU that is not monovalent. See Hydrogen, a special case 
BSU. This option can be switched off by selecting H- Warning Off    from the Preferences menu. This 
setting is saved and is active for all sessions until changed. 



H- Warning Off (Preferences menu)

Allows you to connect a hydrogen to a BSU that is not monovalent. See Hydrogen, a special case BSU. 
This option can be switched on by selecting H- Warning On    from the Preferences menu. This setting is 
saved and is active for all sessions until changed. 
 



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using this application and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About ... command (Help menu)

Use this command to display the copyright notice, version number, and license agreement for this copy of 
the application.



Context Mode command 

Use the Context Help command to obtain help on some portion of the application.    When you choose the 
Toolbar's Context Help Mode button, the mouse pointer will change to an arrow and question mark.    
Then click somewhere in the Easy C Base standard interface window, such as another Toolbar button or 
menu item.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name Easy C Base and the name of the 
active Chemical Record File.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Chemical record file Control-menu button
Maximize button
Minimize button
Restore button



Scroll bars

Displayed at the right and bottom edges of each of the window panes in a given Chemical Record File.    
The scroll boxes inside the scroll bars indicate your vertical and horizontal location in the structure, text, 
or BSU pane.    You can use the mouse to scroll to other parts of a given window pane.



Size command 

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command 

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command 

Use this command to reduce the Easy C Base window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command 

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a Chemical Record File window.



Next Window command 

Use this command to switch to the next open Chemical Record File window.    Easy C Base determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command 

Use this command to switch to the previous open Chemical Record File window.    Easy C Base 
determines which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command 

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single Chemical Record File, the Close command on the 
Chemical Record File Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a Chemical Record File window

ALT+F4 closes the Easy C Base application window



Restore command 

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command 

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



What is Easy C Base?

Easy C Base is a general purpose chemical structure database and drawing standard interface. 
Programs that use this standard interface allow you to quickly enter structures through an easy to use 
combination of mouse pointing and graphical icons. With each structure, you may associate up to 32,000 
bytes of textual and numerical information. This information is entered and edited using a text editor 
similar to the Windows Notepad. You may search for records using exact structure, a substructure, or a 
text string that occurs in the chemical's name or text description. Easy C Base's substructure search is 
unique in that it can be used to perform searches that specify several substructure segments in a given 
molecule. 

Structure and information for each of the chemicals in the database are stored in a regular Windows file, 
separately. This makes it    easy to copy, distribute, or transfer (across a phone line or network) 
information for individual chemicals. A powerful search engine enables you to treat these chemical files 
just as if they were records in a database. Thus you can search for a chemical by exact structure, 
substructure, name, or a text string that appears in the textual description associated with the chemical 
structure. You may have multiple files open in multiple windows. Easy C Base calculates the molecular 
formula and molecular weight every time the chemical structure is changed and displays them in the 
Status Bar of the file window.

The graphical interface consists of three window panes: one displays the chemical structure, another the 
textual and numeric information associated with the structure, and the third a palette of atoms and 
common groups that you use to create a structure. The window Status Bar displays the name of the 
chemical, its molecular formula, and its molecular weight. To perform a structure search, you simply 
indicate which open window contains the structure you would like to search for. Easy C Base will return a 
list of any matching records and will automatically open them for you if you so wish.



Basic Concepts

The Structure Window Pane in Easy C Base is divided into imaginary squares. Each square can only hold 
a single BSU. BSU's can only connect to each other along STRAIGHT LINES that are either 
HORIZONTAL, VERTICAL, OR DIAGONAL. Thus the two CH3 groups on the right in the above figure are 
not connected and are treated as such by Easy C Base. In the representation of acetic acid on the left, in 
the above figure, all groups are connected and form a molecule. A special type of BSU, a bond extender 
can be used to connect BSU's that are more than one square apart. This is especially useful when 
constructing cyclic or complex structures. 

You place a BSU in the Structure Window Pane by clicking on its button in the BSU Window Pane . The 
BSU is placed where the Red Focus Square is. The orientation of the BSU is automatically chosen to fit 
adjacent connections if any are present. If you do not like the orientation of the BSU, click on it in the 
Structure Window Pane to position the Red Focus Square over it, then click on it again. The orientation 
changes to the next available orientation that fits any adjacent BSU's. Keep clicking until you find the 
orientation you like. Note that a BSU's orientation does not affect how Easy C Base searches for a 
structure.

In the Text Window Pane, you may enter any textual or numeric information up to 32,000 characters. This 
pane is a screen editor in which you can move using the mouse or the cursor keys. You may also copy 
information between it and other applications that support the clipboard. Text automatically wraps to the 
next line depending on the size of the Text Window Pane. Use the Return (or Enter) key only to start a 
new paragraph. When you print the text, it will be formated to print within your printer's page and text will 
automatically be wrapped to new lines. It is IMPORTANT that you realize that the    Text Window Pane is 
NOT a WYSIWYG editor.

You can change the relative sizes of the three window panes to each other by clicking on the horizontal or 
vertical split bar separating two window panes then dragging the split bar to a new position, thus 
enlarging one pane while reducing the other.

After you are done with entering structural and textual information, you save it all in a Chemical Record 
File which is just a regular WINDOWS (or DOS) file. You may copy, move or delete that file using the 
WINDOWS File Manager or DOS commands. 

To search for a structure, you draw it then choose the Chemical Search command. In the dialog box that 
is displayed you choose the name of the window that contains the structure you have just entered. You 
click on the Search button, and all the names of the matching chemicals and the files that contain them 
are displayed.



An Example

To get familiar with window elements referenced below, look at Figure 1.

This example illustrates how to draw 2-propane, (CH3)2 CH-OH . 

Adjust the Easy C Base window to a convenient size using the window borders. Adjust the Structure 
Window Pane to a convenient size using the Split Bars. Click in the Structure Window Pane to place the 
Red Focus Rectangle in an appropriate position. 

In the Basic Structural Unit (BSU) Window Pane, click on the icon for CH . The CH group with the default 
connections is drawn and the Red Focus Square moves to one of these connections. Now use the scroll 
bars in the BSU Window Pane to scroll to the OH group icon. Click on the OH icon. The OH group is 
drawn where the Red Focus Square was and the square moves to the next available connection. 

Adjust the orientation of the two remaining connections of the CH group by first clicking on the CH group 
in the Structure Window Pane to move the Red Focus Square over it. Then repeatedly click inside the 
Red Focus Square to move through the available orientations. 

When you see the orientation you desire, click opposite one of the remaining two free connections. The 
Red Focus Square moves there. Now use the scroll bars in the BSU Window Pane to move up to the 
CH3 icon. 

Click on the CH3 icon, the CH3 group is drawn where the Red Focus Square was and the square moves 
to the last remaining connection. Click on the CH3 icon in the BSU Window Pane again; the CH3 group is 
placed where the Red Focus Square is located. The square does not move.

Now, from the Chemical menu, choose Name. A dialog box appears with the string "NO NAME YET" in it. 
Replace that string with the string 2-propane and click OK. The name appears in the left most field of the 
status bar. 

From the File menu, choose Save and save the structure in a Chemical Record File giving it any name 
you wish. 

To see how the Search command works, choose Search from the Chemical menu. When the search 
dialog box appears, just click on the Search button. This will retrieve the chemical names of all the 
Chemical Record Files in the current Database Directory. 



Print Structure command (File menu)

Use this command to print the structure in the Structure Window Pane. The name, formula, and molecular 
weight are also printed. You may use the Print Preview command to see how the printer output would 
look. This command presents a Print dialog box, where you may specify the number of copies to be 
printed, the destination printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print Text command (File menu)

Use this command to print the text in the Text Window Pane. The text is reformated to fit within the page 
margins. You may use the Print Preview command to see how the printer output would look. This 
command presents a Print dialog box, where you may specify the range of pages to be printed, the 
number of copies, the destination printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Easy C Base is sending output to the printer.    The 
page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages 
will be displayed in their printed format.    The print preview toolbar offers you options to view either one or 
two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a 
print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of the current installed printers shown in the box.    You install printers and configure 
ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.





Basic Structural Unit (BSU): 
A chemical group or an atom which is used as a building block to construct chemical structures. An 
example of a BSU is:

This represents the methyl chemical group; by clicking on this icon in the BSU Window Pane, the methyl 
group is placed in the Structure Window Pane at the position of the Red Focus Square. See also: bond 
extender BSU's.



Bond Extender: 
A special type of BSU whose function is to connect BSU's that are more than one square apart. A bond 
extender is treated as part of one of the BSU's it is connected to. There are three types of bond 
extenders: single, double, and triple:

 



Chemical Record File (CRF): 
An Easy C Base database is a normal DOS or WINDOWS directory. Records in Easy C Base are regular 
DOS or WINDOWS files. Thus the name Chemical Record File. A CRF contains the structure and 
associated textual information for a chemical and can be searched for and retrieved as in a normal 
database. It can also be treated as a regular DOS or WINDOWS file.



Database Directory: 
Is the database where Easy C Base stores its records. It is the DOS or WINDOWS directory that contains 
the Chemical Record Files. The directory defaults to the path selected in the CRF Database (Preferences 
menu) when Easy C Base is first started. If there is no path specified, it defaults to the working directory in 
the File Properties command of the Program Manager (the Windows Desktop) or the current directory. 
The directory may change if the working directory is changed by some commands.



Important Note #1: 
Use of the commands or dialogs of: File Open, File Save As; will change the default    CRF Database 
Directory from the default working directory defined using the CRF Database command in the 
Preferences menu. The change is temporary and is not saved when the application exits. This change 
affects where the Chemical Search command looks for records. 



List box contains the titles of the currently open windows in Easy C Base. Select the window in which the 
structure or substructure you wish to search for is displayed. 

Exact structure: 
Click on this radio button to look for a structure that exactly matches the one displayed in the window you 
selected. Orientation and shape do not matter; Easy C Base will retrieve the chemically matching 
structures.

Substructure: 
Click on this radio button to look for a structure that contains the structure displayed in the window you 
selected. Orientation and shape do not matter; Easy C Base will retrieve all the chemicals that contain the 
substructure.

See structure search rules for details on how Easy C Base does its structure searches.



Enter here the string which you would like to search for. The Chemical Name field as well as the Text 
Description associated with each chemical are searched for the string. The search is not case sensitive: 
all chemicals that contain the specified string in either upper or lower case are retrieved.



Click on this button when you are ready to begin your search. The names of any matching chemicals are 
displayed in the window above along with the Chemical Record Files that contain them. The two names 
are separated by " <-|-> ". This button is disabled once the search is completed. It is enabled again only 
when you change the search criteria. If no search criteria are specified, all Chemical Record Files in the 
database directory are retrieved.



The list box displays a list of the Chemical Record Files that matched the search criteria. You may select 
up to five to be opened. The box must be checked. Click the OK button to open them, the CANCEL button 
to abort.



Click on this button to open the files selected in the above box. Up to five Chemical Record Files may be 
opened at one time.



Click on this button to cancel opening any files that were selected in the above list box.



Click on this button to get this help.



BSU Cannot be Connected Message:
This dialog box is displayed when one of the BSUs cannot be connected to a neighboring BSU. You may 
override this warning.

It is also displayed when an attempt is made to link a hydrogen atom to other than a monovalent BSU. 
You may override this warning, but note that Easy C Base will not recognize that the BSU CH2 for 
example is the same as the combination H-C-H . See the keyword Hydrogen, a special case BSU. 



Another BSU Exists at this Location Message:
This dialog is displayed when you attempt to put a BSUs over an existing one. You may override the 
warning and replace the existing BSU with the new one; or you may cancel the operation.



Chemical Name dialog box:
Use this dialog box to give the chemical a name. This name is displayed in the first field of the Status Bar 
of the window displaying the Chemical Record File. When a new chemical record file is first created, the 
name defaults to "NO NAME YET".



This warning dialog box is displayed when performing a Database Directory search and a Chemical 
Record File which cannot be accessed is encountered. To avoid a repeat of this message, change the file 
extension of the Chemical Record File to something other than ".ECB" or remove it from the Database 
Directory.



Structure Search Rules:

The following explains how Easy C Base searches for, and retrieves, chemical structures; both in the 
exact structure search mode, and the substructure search mode.

1- Easy C Base will recognize a chemical regardless of its orientation, shape, or sequence of entry. 

2- A BSUs is the smallest building block in Easy C Base. This means that to search for a given 
structure you must be able to construct it from available BSU's. It means for example that CH2 is 
not equivalent to H-C-H, which is the reason why you are not encouraged to connect a hydrogen 
BSU ( H ) except to a monovalent BSU so that you can construct molecules such as methane 
(CH3-H). 

3- Easy C Base will retrieve all stereo isomers of a given structure or substructure.

4- A substructure search is not limited to connected BSU's. For example, you may look for all 
chemicals that contain certain BSU's (or BSU's connected in a certain way) by just specifying 
these BSU's (or combinations of BSU's) separately in the structure window. For example, you 
may look for chemicals containing the combination CH3-CH2 by drawing them connected; or you 
may look for all chemicals that contain a CH3 and a CH2 group (not necessarily connected) by 
just drawing the two, not connected.

5- When you override an Easy C Base warning regarding the ability to connect one BSU to another, 
the above rules will still apply even though the structure is meaningless. See rule 2 above for a 
potential problem with the hydrogen atom.



Hydrogen, a special case BSU:

One of the features of Easy C Base is that you do not have to worry about placing all those hydrogen 
atoms in organic molecules. To provide this feature, all possible combinations of hydrogen with other 
single atoms are included as BSUs . The only time you will need a single hydrogen atom is when you 
construct molecules such as water (H-OH), or methane (H-CH3). 

To insure a consistent interface, and valid database searches, Easy C Base will issue a warning (see H- 
Warning On)whenever you attempt to connect a hydrogen to a BSU which is not monovalent. You may 
override the warning and connect a hydrogen to a BSU which is not monovalent, but be aware that Easy 
C Base will not equate the two forms (e.g. H-OH is not the same as H-O-H). 

Easy C Base allows you to set a switch to avoid the warning, see H- Warning Off.




